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Disclaimer



	The author, Tremaine Parsons, has taken due care in the preparation of this document and the associated programs. In no event will Tremaine Parsons be liable for damages of any kind, incidental or consequential, in regard to or arising out of the use, performance, or form of this material presented herein and in the programs accompanying this document. No representation is made regarding the suitability of this product for any particular purpose.



�Single Computer License



	The price paid for a single copy of Ptools entitles you to use the program on a single computer. You may remove it from the computer and use it on another, but at no time are you allowed to make multiple copies available for others to use without the express written consent of the publisher.



General Overview



	This computer program was designed to help piano technicians save time by incorporating a fairly broad collection of functions into one program.



	While different Technicians will have varied needs, my goal was to provide some time saving functionality for everyone. With this in mind, it is my hope that this program will prove worth while even if the user only uses one or two of the many features.



	Over the years I have found certain tasks which seem inefficient and annoying. A few examples:



Looking up zip codes is one of my favorites.



I may be comfortable with my word processor but am still addressing my envelopes by hand because I haven't initiated an envelope generator yet.



I should have ordered those parts today, but did not have time to write it up, address the envelope, or phone it in to the supply house. Yes, many times we do need to wade through the catalogues to determine the correct parts. But just as often, we know exactly what we need and should be able to produce a letter/fax ready order in under two minutes.



Oh, this measurement is in millimeters and I need it in fractional inches. Where did I see that conversion chart.



Now, what is the recommended drill size for a #9 bridge pin?



	These are the types of issues that this program has tried to address. I have tried to create a cohesive collection of information and functions so as to avoid wasting time searching, looking up, calculating, or writing.



	The table of contents lists the main program functions as well as most of the additional program functions.



	For those users who currently use a client maintenance module it is possible to use this client module to track other information such as clients who are looking to buy, upgrade, or sell pianos or a simple accounts receivable tracking tool. I will still encourage you to spend an hour or so experimenting: exporting your data to ASCII delimited and importing into the Ptools client database using PTUTIL.



	For users who have not yet computerized their client list, I realize that the task of entering your index cards may seem overwhelming but I can assure you with confidence that one or two mailings will make the time investment worth while. The client module will provide an excellent foundation for computerized client maintenance. The files are in standard DBASE format which should allow porting to broader based client programs should more extensive functions be required in the future. As currently implemented, the client module offers well rounded information tracking.



	I am currently using the Ptools REPLACEABLE DATABASE FEATURE to track my clients, my Ptools users, my Pscale users, a technicians list, and a personal address book.



	This program may fall short in many regards but if it saves the user any time whatsoever on a repetitive basis (daily, weekly, or occasionally), then it will have achieved it's goal



Using This Manual



	My first suggestion is to scan the entire manual without regard to any specific step by step instructions. This will help provide an overview of the various program considerations.



	Then explore the different features in more depth.



Ptools For Windows Files



PTOOLS.OVR		The Ptools For Windows Program Files

PWSETUP.DBF		The Ptools User Set-Up File

*.TXT			The On-Screen Info Files

CL.DBF		Client Data  Files

CLAST.NDX		Client Data Index Files

*.RDF			Replaceable Data Files For Client Module

*.DBT			Associated Replaceable Data Memo Files

*.RSF			Replaceable User Set-Up File

MEMO.DBF		Letter/Notes Data File

MEMO.DBT		Letter/Notes Data File

ZIP.DBF		Zip Code Data File

ITOWN.NDX		Zip Code Index File

RESOURCE.DBF	Resource Data File

IRCONAME.NDX	Resource Index File

????????.LST	Supply House Data Files

PTUTIL.EXE		Utility Program, Zip, Case Convert, Import/Export

WMEMO.EXE		DOS Letter / Memo Editor

SPELLD.DBF		Dictionary for Spell Checking (DOS Editor)

IWORD.NDX		Dictionary Index File (DOS Editor)



The Main Menu



	The following line comprises the "main menu" of the program and appears at the top of the screen when PTOOLS has loaded.



User  Client  Resource  Tools  Parts  Set-Up  Maintenance  Help



	To select any of these choices, press the first letter of the choice, or click the desired selection with the mouse. All of these choices will present a vertical list of additional "sub menu " choices. Selection of those items is performed in the same manner. Press the Esc key to close the box and return to the main menu.



	If you click a selection that requests information, you can always abandon the selection by pressing the Esc key.



The Set-Up Menu



	Let's start by choosing Set-Up to identify your user specific information. From the main menu (no open boxes), click Set-Up and the Set-Up Menu will open up.



User Information			(User Set-UP options and print files)

Change User/Clients		(Replaceable Database File Selection)

Delete User/Clients		(Delete Replaceable Database File)





	The highlight will be on User Information. Click this Item or Press the RETURN key and the USER INFORMATION box will appear.



User Information:



	Fill in the Name, Address, and Phone information.



Note:		The Letter Head Templates supplied with Ptools are in the following format:



User Company Name							( OPT. )

User Name									( Logo)



Therefore, if you use a Company Name, fill this in accordingly. Otherwise, you might consider entering your name for Co. Name and Piano Technician for User Name.



The default client data file name is: CL.DBF



Password:



	I would leave this blank until you are thoroughly familiar with the Ptools Program.



The Memo Margins:



	This setting determines the width of the Memo Letter Edit Box and I would leave this as is until you are thoroughly familiar with the Ptools Program.



MEMO LEFT MARGIN		 5	(<=20 FOR LEFT MARGIN LETTER HEADS)

MEMO RIGHT MARGIN		75



Modem:



	If you have a modem change modem port, dial type, and hang-up string to your configuration. 



Show Deleted Records:



I recommend that you leave Show Deleted Records set to Y.

The Word Processor (Run Programs) Information:



	This information allows you to specify up to three External Windows or DOS programs that may be launched from the Ptools File Menu:



Items in the Name field will appear in the Ptools File Menu as Program selections.



Items in the Path/File field is the program’s Location and the Name of the executable file



Items in the Files field is the Location (and optional filename) for files that Ptools exports for the purpose of an external mail merge using the program defined in the Path/File field.



Note: the trailing \ is not normal DOS or Windows syntax to identify a directory location. However Ptools requires this \ because you will use this field information when you supply a filename for many of the Ptools Export Functions (See Export in Clients, Resources, etc.).



Items in the (W)in (D)OS field designate a Windows or DOS Program



Click Continue or press Esc to advance to the next User Info screen.

PTOOLS Printer Template Files



	Ptools provides a number of predefined report forms for printing Letter(heads)/Memos, Labels, Envelopes, Client data, etc.



	In this Set-Up screen you can specify the Report filenames that most suit your needs. 



	In most cases there are only three filenames that you will change. Memo / Letter,  Envelope,  and  Merge Memo / Letter



Memo / Letter:





MEMLO.RET		Original PTG Logo RPT ONLY single line footer

MEMLO3.RET		Original PTG Logo RPT ONLY triple line footer

MEMLODW.RET		Original PTG Logo RPT ONLY Double Window Envelope

MEMLN.RET		New PTG Logo RPT ONLY single line footer

MEMLN3.RET		New PTG Logo RPT ONLY triple line footer

MEMLNDW.RET		New PTG Logo RPT ONLY Double Window Envelope

MEMLNA.RET		New PTG Logo ASSOCIATE single line footer

MEMLNA3.RET		New PTG Logo ASSOCIATE triple line footer

MEMLNADW		New PTG Loge ASSOCIATE Double Window Envelope

MEMNL.RET		No PTG Logo single line footer

MEMNLDW.RET		No PTG Logo Double Window Envelope

MEMPLN.RET		For Pre-Printed Letter Head 2” Top Margin

MEMPLN1.RET		For Pre-Printed Letter Head 2” Left Margin



Envelopes:



ENVLO.RET		Envelopes with Original PTG Logo RPT ONLY

ENVLN.RET		Envelopes with New PTG Logo RPT ONLY

ENVLNA.RET		Envelopes with New PTG Logo ASSOCIATES

ENVPLN.RET		Envelopes with No PTG Logo



Merge Memo / Letter:



MERLO.RET		Orginal PTG Logo RPT ONLY single line footer

MERLO3.RET		Original PTG Logo RPT ONLY triple line footer

MERLODW.RET		Original PTG Logo RPT ONLY Double Window Envelope

MERLN.RET		New PTG Logo RPT ONLY single line footer

MERLN3.RET		New PTG Logo RPT ONLY triple line footer

MERLNDW.RET		New PTG Logo RPT ONLY Double Window Envelope

MERLNA.RET		New PTG Logo ASSOCIATE single line footer

MERLNA3.RET		New PTG Logo ASSOCIATE triple line footer

MERLNADW		New PTG Loge ASSOCIATE Double Window Envelope

MERNL.RET		No PTG Logo single line footer

MERNLDW.RET		No PTG Logo Double Window Envelope

MERPLN.RET		For Pre-Printed Letter Head 2 1/2” Top Margin

MERPLN1.RET		For Pre-Printed Letter Head 2 1/2” Left Margin



Ptools Printer Templates  (Cont.)



Additional considerations:		(Printed Output)



		You should keep in mind that the Ptools Printer Template Files are included to provide basic functionality within the Pools program. However, such templates will likely fall short of the way you would ultimately like to see your printed output. Therefore, I have made every effort to make it easy for you to export your data to an ASCII.TXT file so that you may merge this data within forms created with the word processor of your choice.



	I recommend that you initially experiment with the Ptools internal print functions. Under many circumstances, the results will prove adequate. Once you have a feel for the program, I would then start exporting your data (filtered ?) to your favorite word processor directory and experimenting with your own custom forms.



Change User/Clients:



	This selection will open a File selection Box and allow you to select a replaceable database file. These files have the same data structure as the default client file (CL.DBF,CL.DBT) but have a filename extension of .RDF. When you select one of these files, it becomes the active “Client File” for the Client main menu option.



	Creating new replaceable database files is detailed further in the Export Button description of the Edit Client Data section of this manual. However, in short, you filter on current(for a file with 1 record), select Export, select  No=.RDF ,enter a filename, and a single record is exported to a new replaceable data file. You then edit and add data to build a new database.



	The first time you select a .RDF file a setup file is created 

with the same name but a .RSF extension (replaceable set-up file). This becomes the .RSF file used in the User Information under Set-Up.



Example:	(next page)



Default -> CL.DBF, CL.DBT, and PWSETUP (user information)



Select RDF -> YOURFILE.RDF, YOURFILE.DBT, and  YOURFILE.RSF



Delete User/Clients:



This selection will delete a replaceable data file. Sometimes you will create RDF’s in order to do a compound filter or append them to an existing RDF (Maintenance, Delete / Get). After, you use this feature to delete the temporary RDF. User/Client files may not be deleted if it is the currently selected file. Select a different User/Client file and then delete.



Finally, the CL.RDF listed in the file selection box is a dummy file that you select to inform Ptools to return to the default CL.DBF file.



The File Menu



From the main menu, click User or press the ENTER key with User highlighted and the User box will open and present the following sub options:



MSWrite			(or program as defined in Set-Up)

WinWord             	(or program as defined in Set-Up)

Word Perfect /DOS   	(or program as defined in Set-Up)

^Run File Specs^  	(Run Program / Export File Spec Info.)

Letter / Memo     	(Create/ Edit Letter / Memo Module)

Make Envelope  		(Envelope Module)

DOS Program			(Run External DOS Program or Command)

Windows Program		(Run External Windows Program)

Exit				(Exit This Program)



The first  3 items:



MS Write			(or program as defined in Set-Up)

Winword             	(or program as defined in Set-Up)

Word Perfect /DOS   	(or program as defined in Set-Up)



run  the programs as defined in User Set-Up, User Information.



^Run File Specs^  	(Run Program / Export File Spec Info.)



	This choice will open the Run File Info/Export File Info box. This info box is similar to the User Info run program information with the exception that it allows you to override the info as set in Set-Up, User Information. However, any changes that you make within this window will remain in effect until you restart PTOOLS or change  the information in User Information under Set-Up.



	The object is to click the desired application or program that you plan to run or send an export file. This in turn will open the fields so that you may change the parameters. i.e. Add or change an export filename in File Location\Name, change the App. Location\Name, or add a parameter to the App. Location\Name to run a macro at startup or open a file at startup.



This is a dual purpose window:



App. Location\Name



	Designates the program to run with optional filename or macro name as a command parameter



File Location\Name



	Location (path) and filename for any ASCII exports of your data.



Also: See Export, Yes=ASCII within the Client Module documentation. 



The Letter / Memo:



	The Letter / Memo choice accesses functional Ptools word processors included to generate quick letters, parts lists, or other correspondence. The main reason these word processing modules have been included is for a quick interface with the client, resource, and parts modules. While working in these other modules the Grab Button will "grab" header information (name, address, etc.) of the respective module so that the user may dump this info into the Letter / Memo. While the editing functions may fall far short of your favorite word processor, they should suffice for the quick past due reminder, parts list, or letter requesting info on a resource product. The Letter/Memo can also access your favorite word processor as detailed under the External File Column below.



When you select Letter/Memo, you are presented with several Button options as well as a list of memo/letters under the Contents column. There is also an External File column which will be detailed below.



With the exception of the Edit Button, the other buttons are straight forward so I will detail them first.



Add		Requests a Contents description of a new Letter/Memo

Print		Will print a Letter/Memo

Sort		Will Sort the contents column in alphabetical  order

Import	Will Import an ASCII text file into a Letter/Memo(**)

Export	Will Export a Letter/Memo to an ASCII text file (**)

Delete	Will Delete a Letter/Memo



Edit		(next page)



	If you click Edit, you are prompted to select Yes for DOS Editor, No for Windows Editor, or Cancel.



	Huh? Why is there a DOS editor in a windows program?



	Ok!, Here’s the Rub! Ptools for DOS or Windows is essentially a DBASE database program. In DBASE, or FoxPro, or MS Access, there is what is called a MEMO type field that may be included in the database file structure. The Memo Field is for storing text info that may be longer than a typical Name or Address type field. I have used this field type for the Letter/Memo Module. Because of this, there are certain limitations with regard to the size (length), or control of the Letter/Memo. These vary within the DOS or Windows versions of Ptools. I have therefore included access to both a DOS Letter/Memo editor and a Windows Letter/Memo editor.



	Basically, there is some compromise here because the Windows development platform that I am using for Ptools for Windows currently falls short in its handling of Memo Fields. I am continuing to address these shortcomings. On the up side, the DOS editor includes a basic spelling checker.



(**) The following info also pertains to Import & Export as well.



The Windows Letter/Memo Editor:



	The windows editor is currently limited in to 5000 bytes in size. This might be about a page of text.



	In addition, formatting within this editor does not always agree with the printed output when you print the Letter/Memo for the following reasons:



The databases within Ptools (CL, Resource, Parts, etc.) are in fixed pitch. Therefor, when you grab info from the parts database and paste into the windows Letter/Memo editor the part #, description and price will not appear in columns. This is because the windows editor uses proportional spacing.



	However, if you close this Letter/Memo (Memo, Save and Exit) and reopen it with the DOS editor the text will be in column format.



Rule of Thumb:



	Use the Windows editor for pasting or copying functions and the DOS editor for formatting and  composition.



	If you are grabbing info from the Client, Resource, or Parts modules to paste into a Letter/Memo, grab the info (detailed later), edit the memo with the Windows editor. Click Edit, and then paste. The info will be pasted. Close the Letter/Memo (Memo, Save and Exit) and then edit the Letter/Memo with the DOS editor.



The DOS Text Editor



	The DOS editor will, usually allow 3 to 4 times larger (longer) Letter/Memo’s. The size is partly determined by the amount of available memory in your computer. It is therefor recommended that you edit your Memo/Letter’s without other programs loaded or running within Windows. For example, if you have Street Atlas loaded and are running Ptools for Windows the memo size limitation could actually be worse than the 5000 byte windows editor limitation.



	Basic text editing  functions are included and are detailed in the F10 Help screen.



Executing Control Key Sequences: ^Y , ^N, ^G, etc.



	Most editing functions are invoked by executing control key sequences. For example, to delete the current line, you would execute a ^Y sequence. That is: While holding down the Ctrl key, press the Y key and the current line is deleted. Hold down the Ctrl key and press the N key (^N) and a new line is added. Hold down the Ctrl key and press the G key (^G) and the current character is deleted. Pressing F10 within the text editor will display all editing commands.  



Spell Checking



	When you exit the DOS Letter/Memo you are prompted to spell check. To spell check press Y at the prompt. The spell checker will process each word in your memo line by line. Any word that is not found in the dictionary will be highlighted and spell checking will pause. At this point you may choose any of the 5 options listed on the bottom line of the screen.



1 Skip	(skip current word)

2 Suggest	(suggest a pick list of replacement words)

3 Add		(add current word to dictionary)

4 Edit	(edit and replace current word)

5 Look Up	(look up a word in the dictionary)



	It should be noted that: 1 Skip, 4 Edit, and 5 Look Up remain active from within the 2 Suggest pick list.



Make Envelope:



	With this selection you are first prompted whether you would like to Preview Print, Print, or Cancel. I recommend Preview Print on all Ptools print options until you have become used to working with all of the Ptools print options. When you preview, you will have to open the File Menu within the Ptools Report Generator and select Print.



	You are next prompted to select Buffers or Custom. If you select Buffers, your name and info will be used in the return address area and client, resource, or supply house header information will be used in the send to area. Client, resource, or supply house info should have been previously stored using the Grab Button within their respective modules. If you select Custom, you manually supply return and send information for the envelope.



You are next prompted to select Laser, Dot Matrix, or Export. Laser or Dot Matrix is self explanatory.



	The Export option has been included to give you additional printing flexibility. You may export the envelope data to an ASCII file and use a template created with the word processor of your choice. This way you could use your pre-printed Biz envelopes, or layouts that use graphics or logo’s that you have designed. If you export to an ASCII file, you basically set up merge between the envelope you design and the ASCII export file.



	Selecting Export will open the Run File Info/Export File Info box. This is detailed under ^Run File Specs^ above in the File Menu Section. Also: See Export within the Client Module documentation. 



�DOS Program:



	This selection allows you to run DOS Programs or Commands (copy files, dir, etc.) from within the PTOOLS program. You may also run Ptools for DOS with this option. Why would you want to regress to a DOS version of PTOOLS? Off hand, I can only think of 2 reasons: Ptools for DOS is faster (you are on a 286 or 386 machine), or you want to apply compound or custom filters like TDATE <  91 .and. (City = “Lincoln” .or. City = “Concord”) .and. “STEIN” $ MFG



	Actually, speed will never be an issue unless filter conditions are applied.



WINDOWS Program:



	This selection allows you to run WINDOWS Programs from within the PTOOLS program.



Exit:



	Make this selection to exit The PTOOLS program.



	The Client Menu



	I would like to point out that if you are already using a computerized client management program, you should read and practice these detailed features as the Client commands are nearly the same as the resource module. You can also use this module for other purposes such as accounts receivable, clients wanting to sell, buy, or upgrade, or a personal address book for Technicians.



	From the main menu click Client and the Client box will open and present the following sub options:



Edit Client Data		(Open client file for edit functions)

Browse No Index		(Included for Slower Computers)

Back Up Data        	(Back up data files)



Edit Client Data:



	Selecting this will display your client file for further action. The top rows of the window display Buttons for actions you may perform and will be detailed below. I have included about 2 screens worth of data for you to experiment with in order become familiar with the various functions. To remove these clients refer to the Delete description below. Also: PgDn,PgUp,CtrlEnd,Ctrl Home scroll the screen.



Button Descriptions:



Find:			(Within Client Screen)



	Click Find to find a client. The client last name must be entered exactly as stored i.e. spelling and upper/lower case must match. With a successful find the highlight bar will be placed on the client for further editing or updating by clicking Edit to open the edit window.



�Edit:			(Within Client Screen)



	Click Edit to open the edit window of the currently highlighted client name. The cursor keys will navigate through different fields or you may click on any field that you wish to edit. You should skip over the History Field as this information is automatically "stuffed" with the previous tuning date each time you update the TDATE field. Refer to the Add Button description below for addl. information.



Important: Additions or changes to the client fields will not become permanent until you press the enter key and advance to the next field. Or, click on the next field with the mouse.



	Buttons within the Edit Window:



	Zip		(Within Edit Window)



	While in the Edit window you may click Zip to automatically stuff a State and Zip Code into their respective fields based on the town that is entered in the Town Field. i.e. Enter a town, click Zip and the State abr. and zip code will be stuffed. Then click on the next field that you wish to edit. Note: you will be warned if the town is not found or if multiple zips exist for that town. In this case, the zip table will pop up and you have the option to select a zip code. You will have to use PTUTIL to make a Zip database for your state(s).



	Memo		(Within Edit Window)



	While in the Edit window you may click Memo to add or edit additional client information. Navigation and editing functions are the same as in the Letter / Memo editor.



	Cal		(Within Edit Window)



	While in the Edit window you may click Cal to insert tuning dates and times into the Ptools scheduling Calendar.



SubFind:		(Within Client Screen)



	SubFind will prompt you to enter a last name or a portion of a last name(Upper/Lower case specific). Usually the first 3 or 4 letters will get you close enough to the name you want so that you may use the mouse or arrow keys to position the highlight bar on the client you want. When positioned you may click Edit for the edit window. Note: SubFind requires a sorted database, refer to the Maintenance Menu. Note: SubFind will not always stop on the first occurrence of the search pattern so you may have to back up a few records to find what you are looking for.



Add:			(Within Client Screen)	



	Clicking Add will prompt you to enter a client last name. Enter a last name, press the ENTER key and the edit window will open for further data input. Enter information in the respective fields pressing the ENTER key to advance to the next field. The up and down arrow keys will also advance or retreat from field to field. Clicking on a field will go to that field. Pressing Esc or clicking Exit will close the edit window and save data or data changes. 



Important: Additions or changes to the client fields will not become permanent until you press the enter key and advance to the next field. Or, click on the next field with the mouse.



Try entering a sample client now. Remember, TDATE format is: 94-10

Day: 03 and Time: 10:30a, 12:00, or 3:00p (more about TDATES below)



	A data entry field designated MP has been added. This is a multi-purpose field for serial #'s, last tuning fee, or other information. At the present time PTOOLS does not support financial record keeping.



	Consideration should be given to whether you enter your client data in all UPPER CASE or Mixed Case. All upper case is faster for data input edits, finds, etc. but will not look as nice on mailing labels, envelopes, or letter headers. Mixed case looks nicer on printed output but is a little slower for data entry and you must match case when entering Names or Partial Names for a find function. Included with the program is a utility called PTUTIL.EXE which will allow you to change all UPPER CASE DATA to Capped First Letters (will require some finish correcting) or all data to ALL UPPERCASE or all lower case. See section on PTUTIL later in this manual. Try to enter names like D'Elia as D' Elia as case conversions will be more accurate.





	You can devise different symbol or code schemes for the pitch raise and comments fields which will increase your filtering power. For example a S in the pitch raise field could signify a piano that is/was sharp, a Y, you raised pitch. A * in the comments field could indicate a string breaker. Teacher in the comments field will allow you to view only Teachers.



	When calling clients, if you enter the date, day, and time of the next scheduled tuning, you will be able to print a given day's schedule. See Reports below.



WHAT THE HECK KIND OF DATE IS 94-10 ?



WHAT THE HECK KIND OF DATE IS 94-10 ?



	Let's talk about date formats for a moment. I thought long and hard about the above year-month format and there will be some who will likely prefer the more standard 10/01/94 format. Let me share a few of the reasons that I set the date format this way.



The 94 is the left most and easiest to find item.

	

This allows more screen space for names. (or hyphenated last names)



The day of the month may be entered in the edit window if desired.



The time of day may be entered in the edit window if desired.



Search or filter functions are faster.



94-10 is a little more subtle if included on mailing labels.



Etc. Etc.



	While this format may take a little getting used to for some, I think the benefits out weigh the costs. I hope you will agree.



	The School/Church/Co.Name field has been provided to detail the formal institutional name. If you use this field, then the First and Last name fields should contain the contact person at the school, church or company.



	The Merge/Memo Salutation field has been provided to give your mail merge print-outs a personal touch. Some clients deserve only a first name (friends) while others will require a Dear Mr. and Mrs. Smith. You can fill in this field with the salutation that you want to appear in your merge/memos.



Fred,

Dear Mrs. Smith,

To the folks at 31 Downing Street,

I thought you like might to know:



	When you create your Letter/Memo Template file place [MMSALUTE] where you would place Dear So and So... This allows complete control of your opening salutation.



Filters:		(Within Client Screen)



	Clicking the Filters Button opens a window with options for filtering your client data. When you set a filter, only clients matching the filter conditions are displayed on the screen. It should be remembered that filters on town, mfg, type, pr, and comments are Upper/Lower Case specific. That is: searching for  needs rebuild  in comments will not work if you entered your data as NEEDS REBUILD. Filters designated with a $ (Sub String of the data content) require only a partial character match. 



Brief description of filters:



TDATE		=	Display for a specific TDATE i.e. 94-12 [DAY]

TDATE Yr.	=	Display for a specific Yr. i.e. 94

TDATE    	<	Display for TDATES before specified Yr.<94

Town		=	Display for specified town i.e. Lincoln

PHONE		=$	Display for number or partial number i.e. 259-

MFG		=$	Display for MFG i.e. Steinway or Stein

TYPE		=$	Display for TYPE i.e. Upright or Upr

Pr		=	Display for PITCH RAISE i.e. Y or other symbol

COMMENTS	=$	Display for COMMENTS or partial i.e. Teach

CALL		=	Display for CALL        

CALL		<	Display for CALL less than date i.e. < 94-06

CURRENT		Display fot CURRENT client only



TDATE =	(Has Dual Filter capability)



	If you select this option, there are 2 data entry fields. The 5 character YR-MON entry and a 2 character DAY entry. If you leave the DAY field blank the filter will be set to year and month only. If you include a number (03) in the DAY field, the filter will be set to year, month, and day. This has been included so that if you "pre-enter" your tuning dates and times you may display or print a tuning schedule for a given year, month, and day.



Compound Filters:	Example:	Tdate < 95-01 and Town = “Lincoln”



	Currently, the only way to do a compound filter is to apply a filter on, say, TDATE < , click export, select NO=.RDF, and export the filtered data to a file named, say, PRE91.RDF, then select this new file with the Set-Up, Change User/Clients option and apply a filter for Town = “Lincoln”. Then perform whatever print options you desire. After, you may delete PRE91.RDF with the Set-UP - Delete User/Clients option. However, you must first re-select a different .RDF client file (to close  PRE91.RDF) before you can delete the PRE91.RDF file. Refer to the Export description below for more information.



Grab:		(Within Client Screen)



	Clicking Grab will “grab” the name and address of whatever client the highlight bar is designating. You are given the option of including your name and address as well. It stores this information in a memory buffer (and the windows clipboard) so that you can dump this info into a Letter/Memo or envelopes.



Show Grab:	(Within Client Screen)



	This shows the information that is currently in the grab buffer (and clipboard). 



Mark Delete:	(Within Client Screen)



	Clicking the Mark Delete Button will mark the highlighted client for deletion from the database. The word Del will appear at the bottom of the screen. This only marks the client for future deletion. To permanently delete, you must select Delete from the Maintenance Menu.



Note:	

	To remove all sample clients from the client file, use the arrow key, position the highlight bar on each sample client, and press the Del key. Then use the Maintenance Menu to permanently delete the sample clients.



Schedule:		(Currently supports CL.DBF Only)



	The first time you click the Schedule Button, you will be prompted to build a calendar database. Enter a start and end year. I suggest that you start with 2 years. (you have the option to modify or rebuild later) Ptools will build a calendar and process the CL.DBF to enter tuning dates and times in the calendar. If you are a new user, there will likely be little or no info to place into the calendar. However, as you work with Ptools, you will be able to start placing appointments in the calendar if you wish.



	I personally use a month at a glance to schedule and maintain the computer calendar in parallel. I need to be able to schedule anytime, anywhere without the computer. I maintain the computer calendar in parallel so that I can print out weekly or daily schedules to leave by the phone for my family. Or, in case the worst happens, my monthly gets lost. It has never happened, but I never say never.



Working Inside The Schedule Module:



	Once you open Schedule, you should see the current month. The current day should be designated with << >>. Click on any day with the mouse and the day window will open. Press Esc to close the day window.



Navigation and Maintenance:



	The bottom line of the calendar should display 7 commands invoked by pressing the first letter of the command.



(N)ext   (L)ast   (G)oto   (E)xit   (C)ust   (P)rint   (M)aint



(N)ext	Next Month

(L)ast	Last Month

(G)oto	Goto Month

(E)xit	Exit the Calendar (or use the Esc Key)

(C)ust	Browse Client Database

(P)rint	Print Month, Week, Day

(M)aint	Maintenance (Add Year, Delete Year, Rebuild and Refresh)



Adding an Appointment to the Calendar:



Recommended procedure for adding an appointment:



	If the calendar is currently displayed, press Esc and return to the client screen.



Use the Find or SubFind Buttons to locate the desired client. The highlight bar should be on the client.

Click the Schedule Button and open the Calendar.

Click the desired day and open the day window. (Current Client= should be the client you previously found)

Click the Insert Button to open the edit window and enter a time

( 9:30A) (10:00A)(12:00 ) ( 3:00p) etc. AND PRESS THE ENTER KEY!!

Press the Esc Key (appointment will be inserted

Press the Esc Key to close the day window



Alternate Procedure for adding an appointment:



	With the Calendar displayed, click open the desired day window.



Click the Edit Button and enter Time, correct Last Name and Phone

number (remember to press the Enter Key)



	If the name(case sensitive) and phone were correctly entered the appointment will be entered. Otherwise you will get a Not Found Message and the option to browse client data to verify the correct Name and Phone number.



	The disadvantage here is that you must have the correct name and �phone for the program to locate the correct client.



Note:	You may also insert appointments from within the client Edit window. (see Edit description under Edit Client Data)



Dial:		(Within Client Screen)	



	If you have a modem installed with your computer, This button will dial the highlighted client. When you hear the call start to ring, pick up the receiver and press the space bar to turn off the modem.



Reports:		(Within Client Screen)



	Clicking this button opens a window and displays print options for printing your client data. 



Short		TDATE, LAST NAME, FIRST NAME, PHONE, AND CALL DATE  

Medium	ABOVE INFO + ADDRESS, CITY, STATE, ZIP, AND PHONE2

Long		ABOVE INFO + HISTORY, MFG, COMMENTS, TYPE,PR, AND MP	

Current	LONG INFO + MEMO INFO (The Client that is highlighted)



Note:	If you have filtered on YR-MO-DY Long will print a schedule for the day specified.



Merge/Memo:



	This print option linked to the Letter / Memo module (File sub menu) and will pop up the list of your Letter / Memos. You select your pre-created tuning reminder and it will be printed for each client displayed under the current filter condition. Each clients name, address, tdate, etc. will be merged with each copy of the memo as defined by field names within brackets []. You should experiment with these features using a tight filter. (a filter with only a few matches to save time and paper)



	 You will find two sample tuning reminder letters (Tuning Reminder and Tuning Reminder/Pitch raise) that you may edit if you wish (edit Letter / Memo). If you look at these samples you will notice the following date designations: [MO]-[YR]. You can change how the date appears by editing this to [MO]/[DAY]/[YR] . You would also want to change the wording of the letter to reflect this format. Note: The field names must be surrounded with [FIELDNAME] and in UPPERCASE.



Field Names Supported by Ptools Merge:	[MUST BE IN UPPER CASE]



[YR] [MO] [DAY] [TIME] [CALL] [MP] [MMSALUTE]



[FIRST] [LAST] [CLCONAME] [ADDRESS] [CITY] [STATE] [ZIP]

 

[PHONE] [MFG] [TYPE] [COMMENTS] [COMMENTS2] [PREVIOUS]



Labels:		(Within Client Screen)



	This Button displays the mailing label / custom label menu. If for any reason you do not use the client module for your clients you still must access the label menu from the client module.



	I would like to note at this time that it is highly recommended that you practice label printing with plain paper before committing your costly label stock to the appetites of your printer.



	Choices 1 - 4 are for HP compatible laser printers as well as Ink Jet printers. Choices 5 - 8 are strictly for dot matrix printers. Most office supply houses stock AVERY laser labels and the AVERY stock numbers are listed on the screen.



	The print routine is subject to any filters you have applied using the Filters Button so you should set your filter condition before you print labels. For example: I want to print labels for everyone I tuned for during this month last year. Click Filters, choose For TDATE =, enter the year-month date for last year, and the display should show only clients for the TDATE entered. Now click Labels and make your desired label choice. It is also important with Laser printers to determine which side of the label stock gets printed on (face down side on my printer) so that the labels get printed on the correct side. 



	For custom labels you are first prompted for the information you want printed on the labels and then prompted for the number of pages that you would like to print. If I am making return address labels, I left justify the text. If I am making information labels, I center each line of text.



Export:		(Within Client Screen)



	Export is subject to the current filter condition so if there are no filters active, the entire client database file will be exported.



	When you click the Export Button, you are first prompted for the type of file you want to export to:



Yes = ASCII		No = .RDF		Cancel



	Yes = ASCII



	If you select this button, the Run Program/Export File Info window will open. Select the button that designates the program you will likely use to process the ASCII export file. This will open the fields with program and file info for editing. The default information in these fields is determined by User Info under Set-Up. I use a default export file name of EXP.TXT and define that in User Info. If you have not defined a filename you should enter one on the second line of the fields and it should look similar to:



c:\directory\yourfile.txt



	With your export file defined press the enter key and a new export window will open. You will see status information and a prompt for:



(C)urrent Client or (F)ilter Condition	

		

Filter is the default and Current is provide for the option of exporting without previously applying a filter on someone’s phone to single out only one client. This is handy if you use an envelope template with your �word processor. i.e. Find the client, export with the (C)urrent option.



	Press the Enter Key and the ASCII export will execute.



	No = .RDF



	Click this Button, and an Export to Replaceable Data File (.RDF) window will open. Enter a filename (YOURFILE.RDF) and the data will be exported to a client Replaceable Data Base File. You can then select this new file under Set-Up, Change User/Clients.



Call:			(Within Client Screen)



	This Button lets you edit the Client Data screen directly without opening an edit box with the Edit Button. This is allowed for quick update of the call column. You will notice that TDATE is not available. This is because Ptools has to process TDATES into others fields (numeric) for several other functions.(filtering, 1999-2000 etc.) In Ptools for Windows, I do not yet have the control to allow TDATES to be edited in this fashion. This is available in the DOS version.



	Note: If you filter on a TDATE and then click the Call Button, the filtered TDATE will appear in the status line at the bottom of the window.



View All:		(Within Client Screen)



	This Button lets you view all of the CL.DBF fields without opening an edit Box with the Edit Button. Editing is not yet permitted.



Alt.Names		(Within Client Screen)



	This Button will list only the client records that contain info in the School/Church/Co.Name field. This is provided to aid you in finding a record when you can not remember the last name of the person to contact at the School/Church/Co. Editing is permitted



End of command button descriptions within Edit Client Data screen.



Browse No Index:



        Browse No Index is the second option of the Client sub menu box. This option has been included for older, slower computers such as a 286, 386, or similar computer.



        When adding or editing client information in regular edit mode you will notice little speed degradation. However, if you apply filters, slower computers may show significant lard-like performance.



        Regular edit client data mode uses an indexed file in conjunction with the client.dbf file and this is slower than using only the data file without an index. At the same time using a non indexed file does not display your data in alphabetical order unless the file is sorted. You can sort the data files using from the Maintenance Menu.



        If you start to squirm in your chair when applying filter conditions you can use the Browse No Index mode for faster performance. If you use Browse No Index mode you may want to sort your cl.dbf file from time to time so that the last names will appear in index order.



Note: You should Back Up your cl.dbf and cl.dbt file to a floppy disk before sorting as the sort writes your data to temp files and then appends them back into your cl.xxx files in indexed order. If lightning should strike or junior pulls the plug in the middle of this process, you could loss your client data. You should also back up your cl.dbf and cl.dbt files on a regular basis anyway should your hard disk crash.



Back Up Data:



	The third option of the Client sub menu will back up data files to another disk drive. You will need a blank formatted diskette for this procedure.



	When you select this option, you are prompted to enter a filename. The default filename provided is CL.DBF. This is the filename of the client file. You could change this to RESOURCE.DBF or ZIP.DBF if you had made changes to those files. You are then prompted for the destination drive letter and destination filename. Again, you can change the default A:CL.DBF to a different drive specification and filename. This routine copies the files for back up purposes. Back-ups are strongly recommended, particularly if you are using the client module (cl.dbf), as hard disks have been known to fail.



The Resource Menu



	From the main menu click Resource or press the ENTER key with Resources highlighted and the Resource menu box will open and present the following sub options:



Go to Resource		(Open Resource File for Edit Functions)

Browse No Index		(Included For Slower Computers)



Go to Resources:



	This option will display the Resource file for further action.



	The use, and actions, of the Resource file is almost identical to the Client file so I am going to ask you to allow me some latitude here and request that you refer to the descriptions of the Client module if you encounter any difficulties using the Resource file. I will, however, detail the minor differences here:



Zip Code:



	This is  your access to both your local (state) and national zip code databases and their respective maintenance functions. (add, edit, delete, etc.) The command buttons are essentially the same as the client module.



Labels and Print functions are not available.



Filters is limited to the key words or partial key words of the product description field. i.e. You can search for words like: PARTS, INSTRUC, �SALES, WOODWORK, FINISH, ETC. (case SpEciFiC)



The Resource module will only export to ASCII text format.



Browse No Index:



        Browse No Index is the second option of the Resource sub menu box. This option has been included for older, slower computers.



The Tools Menu



	The Tools menu is a collection of useful specifications, measurement conversion routines, calculation routines, as well as a note pad for items or specifications you may want to note for future reference.



	From the main menu click Tools or press the ENTER key with Tools highlighted and the Tools menu box will open and present the following sub options:



Music Wire Data                                                 

Drill Data

Pin Data

Recipes

Length Convert

Weight Convert

Fluid Convert

+ - * / ^ Etc.

Bearing Calcs.

Partials

Frequency

User Info



	The following is a brief description of the above sub menu items.



Wire Data:		Displays music wire specifications.



Drill Data:		Displays drill data and recommended tap sizes 					for wood screws and bridge pins.



Pin Data:		Displays specifications for various piano pins.



Recipes:		Displays useful recipes used in piano repair  					procedures.



Length Convert:	Converts specified length measurements to 					different standard formats. i.e. Select the 					measurement you wish to convert, enter your 					measurement, press ENTER, and the conversion 					will be displayed for all other formats.



Weight Convert:	Works in the same manner as Length Convert.



Fluid Convert:	Works in the same manner as Length and Weight.



+ - * / ^ Etc.:	Runs the Windows Calculator 		



Bearing Calcs:	This is a downbearing calculation routine used for 				the following: adjusting bridge height, setting 				plate height, setting allicot bar height, or 					setting  string height on accu-just hitch pins. 				Given the desired angle of deflection and the 					length of the backstring (speaking bridge pin to 				allicot or hitch pin), this routine will calculate 				the desired offset from: the plane established by 				lowering a string to contact the bridge top, to the 				top of the allicot, plate surface, or accu-just 				hitch pin position. General angles are displayed on 				the screen. Also, as a rule of thumb, offset should 				not exceed the maximum amount of crown as measured 				with a string underneath the soundboard.



Partials:		Will display a graph of coincidental harmonics 					within a 2 octave range F - F.

Frequency:		Frequency chart of notes 1 - 88.



The Parts Menu



	From the main menu click Parts, then click Supply Houses and the Supply House list will appear.



Supply House 1.LST

Supply House 2.LST

Supply House 3.LST

Supply House 4.LST

Etc.



	Supply House has been substituted for specific Co. Names as the order and particular Company names has yet to be determined.



	Click the desired supply house and then click OK. The supply house database will the open.



	I would like to stress at this time that access to supply house price lists has been included solely as a convenience to the piano technician for regularly ordered parts and supplies, or general quick reference. As supply houses are adding new products on a regular basis, it should be kept in mind that these lists may not reflect the most current product line or prices. 



Note: Estimate.Lst:



	Included in the supply house databases you will notice ESTIMATE.LST. Select this and you will see the beginnings of a standard repair/rebuilding price list to aid you in preparing an estimate for a client. You can Grab or Export the procedures you wish to include, then paste or import the info into an estimate Memo/Letter that you create. You will want to edit the ESTIMATE.LST to suit your own preferences.



Navigating the Supply House Databases:



	The screen basically consists of Button commands and three columns of data. The columns are: QTY (quantity) Line_Item (description) and M (space to Mark regularly ordered items). The menu commands similar to the client and resource modules. I will detail the menu commands:



Find:



	This works in almost the same way as SubFind within the client and Resource modules. It is CASE SPECIFIC and you only have to enter a portion of the word you looking for. For Example: Let's say we are looking for a CAPSTAN WRENCH. Click Find, enter CAPST, and press the ENTER key. The search will stop at the first occurrence of CAPST. If this is the part you want, click Grab to "grab" the part info, or click Next to continue to the next occurrence of CAPST. Incidentally, all parts data is stored in UPPER CASE so I usually press the Caps Lock key when I enter the parts module.



Next:



	Next continues the Find search to the next occurrence of the key word or portion entered when executing the initial Find search.



Edit:



	This command is now redundant, editing is allowed on screen.



Add:



	Clicking Add adds a new line at the highlight bar location. You must then position the highlight bar on the column in which you want to add info and enter the data.



Filter:



	Filters is limited to the key words or partial key words of the LINE_ITEM field. i.e. You can search for words like: DAMP, MUTE, CAPST, FELT, FINISH, ETC. (case SpEciFiC)



Grab:



	It should be noted that when you enter a supply house data file the first 7 lines (Supply House name, address, phone, etc.) are automatically inserted in the "grab" buffer.



	When you click Grab, you have 3 options:



Grab Line:



	You only have to be concerned with individual parts. The quantity will default to 1 so if this is the case, find the part, click Grab and then Grab Line, find the next part, click Grab and then Grab Line, etc. etc. If you want more than 1 of a particular part you must first quick edit the QTY field and then Grab the line. Or you could just edit the QTY number after you dumped the parts list in the Letter/Memo within File Menu.



�Grab Range:



	This allows you grab a range of parts from say record 45 to 49. If you want damper felt, and you see consecutive parts that you want, use this feature. Enter the start and end numbers to grab multiple parts at one time. The record numbers appear at the bottom of the parts window.



Export Range:



	This allows you to export Parts data to an ASCII file. The range is whatever filter condition you have applied. Say you wanted to send a list of benches to a client. Filter on BENCH, Grab with the Export Range feature and name the export file bench.txt. Esc, open the File Menu, then Memo/Letter, Import bench.txt, and go from there. 



ShoGrab:



	This will show the contents of the Grab Buffer.



Delete:



	This will delete a line from the parts database.



Create:



	This will create a new .LST data file if you want to start a specific parts list, inventory module, etc.



The Maintenance Menu



Rebuild Indexes:		(Maintenance box option 1)



	Occasionally index files need to be rebuilt due to excessive file editing, power failures, etc. If you sense that you have an index problem (the Edit Client Data screen does not look right, or you have trouble finding a client, zip, or resource) click this choice and the Client, Resource, and Zip index files will be rebuilt.



Note:	Rebuild Indexes does not rebuild the Natl. zip code index (NISTATE.NDX) or the Dictionary index (IWORD.NDX) because they are large files and would add a performance penalty. To rebuild these indexes you must erase either file from DOS and then restart Ptools for Windows. Ptools will rebuild any required index files at start-up if they are missing. You can also do this from the Run DOS Program command under the File menu. The command would be: ERASE NISTATE.NDX <ENTER> You will get a Ptools error and have to exit Ptools. Just re-start Ptools.



Sort Data Files:



	This selection will enable you to sort your data files in indexed order for using Browse No Index mode. It sorts the file so that when you do a find, any additional records with the same last name, or Co. name, will appear adjacent to the name found. This option is most pertinent to the cl.dbf,cl.dbt client file and is also required for SubFind to work with optimum speed. You should also back up your files(cl.dbf,cl.dbt) before sorting. 



File Status:



	This option will display file size information on the PTOOLS database and index files. In addition, available memory and diskspace information is also displayed.



Delete / Get:



	This selection opens the Delete, Off-Load, or Get Records box and you may select CL.DBF (or *.RDF) or RESOURCE.DBF. If you select either of these choices, you will see the following command buttons:



	Display:



	This will display all records marked for delete for the database that you previously selected.



	Print:



	This will print all records marked for delete for the database that you previously selected.



	Save To:



	This will copy all records marked for delete to a database filename that you specify for the database that you previously selected.



	Get From:



	This will append from a client file that you specify to the current client database.

	

	Delete:



	This will permanently delete any records marked for delete from the current client database. You will be prompted to confirm.



Check Dates:



	This selection will scan the current client database in use (cl.dbf or *.rdf) for TDATE formatting. If the formatting is correct it will update the other internal Ptools Date/Time fields used in sorting, scheduling etc. If the formatting is incorrect the record info is written to CHKDATE.LOG. The results are displayed at the end of the scan with the MSWRITE editor. Print the results for future correction. File then Exit to continue.



PTUTIL:



	This will run the DOS PTUTIL program for Case Conversions, Imports, and Zip Code Functions. See PTUTIL Below.



	Using PTOOLS with Other Windows Programs



	This section will detail the information you need to use the Ptools Client (or .RDF) and Resource Data with other windows programs: Word Processors, Database Programs, Report Generators, etc.

Word Processors:



	Ptools can export almost all of its data to ASCII Delimited Text format. It will export this data subject to whatever filter condition has been applied. (Town = White Cloud or TDATE = 95-10)



	Almost every word processor that I know of can import ASCII Delimited Text files.(Word, WordPerfect, Ami Pro, etc.)



	The main reason for this is for the infamous MAILMERGE, that dreaded word that sounds complicated. Merging database data within form letters. Well it is not, and who says you have to mail what you merge anyway ?



	Half the battle is getting the data out of the data file into ASCII text format. Ptools makes this easy, click the export button, select ASCII Export, and there it goes. Part 2 is figuring how to set up a template file within your word processor. Well, this is getting easier and easier as software improves. Some programs let you identify the ASCII field position of the line as a number. Some programs pop up a list of the field Info and you select the field to position in your template. Some programs let you do either. Personally, I prefer to identify the position as a number.



	To utilize a Ptools ASCII export you need to know the order of the Data Fields exported from the Data file (.DBF or .RDF)



	The first line of an ASCII export for CL.DBF might look like:



“95-10”,”01”,”10”,”95”,”9:00A”,”Tremaine”,”Parsons”,”Box241”,etc.



	where each line is a client record, each field is in quotes (“Tremaine”) separated by comma’s (,) with each line terminated with a CR LF (Carriage Return Line Feed). The positions would be:



1,2,3,4,5,etc.



Field order for The Ptools CL.DBF (*.RDF) and RESOURCE.DBF



CL.DBF or *.RDF				RESOURCE.DBF



1	TDATE		5 (max length)	1	RCONAME	40 (max length)	

2	DAY		2			2	RNAME		20

3	MO		2			3	RADDRESS	20

4	YR		2			4	RTOWN		20

5	TIME		6			5	RSTATE	3

6	FIRST		20			6	RZIP		10

7	LAST		21			7	PHONE		12

8	ADDRESS	28			8	PHONE2	12

9	CITY		21			9	RFAX		12

10	STATE		4			10	RINFO		40

11	ZIP		10

12	CLCONAME	40

13	PHONE		12

14	PHONE2	12

15	MP		10 

16	MFG		20

17	TYPE		7

18	PR		1

19	COMMENTS	52

20	COMMENTS2	52

21	PREVIOUS	52

22	LASTSPEC	15

23	CALL		5

24	CDAY		2

25	VCDATE	8

26	VTDATE	8

27	MMSALUTE	40



Data Base Programs:



	Many popular Data Base programs can read and write data files used in other programs. One of the most beneficial aspects of this is that you can have more flexibility with printing your client data (Reports). Ptools stores all data in an industry standard DBASE.DBF type file format. This makes Ptools data available to programs like DBASE, Microsoft Access, FoxPro, R&R Report Writer, etc.



	This means that you will never be bound to the Ptools Program 

if you invest the time to manually enter (or Import) your client data. You could use PTOOLS for a few years while you develop your own custom program in Microsoft Access if this is something you might like to do. I obviously do.



Important Note:



	If you use Ptools to manage your clients and you also use other database programs to modify your client data you may have to:



Rebuild Indexes:	(Maintenance) if you have changed any last names or 				added clients.



Check Dates		(Maintenance) if you have changed TDATE, DAY, or 				TIME - Ptools internally maintains numeric values 				for TDATE and DAY, and Military for TIME in other 				fields. This is for sorting and other procedures.





Report Generators:	(Report Engine Technology)



	One positive trend of late in software development is Report Engine Technology. Simply put: The Data Base Program “serves” the client data, and a separate program (Report Engine)(often called or run by the Data Base program) formats and prints the data.



	Ptools for Windows is designed this way. All Ptools for Windows printed output is performed by a runtime version of CA-RET (Computer Assoc. Report Engine Technology). This means that if you happen to already have a report engine that reads DBASE.DBF files you may design your own output as you wish limited only by the program you have. In creating your own report you would identify a *.DBF file as the data source



	Currently, the Ptools Report Engine (CA-RET) does not allow you to create you own report templates or modify the ones that I have provided (*.RET). In the future, I hope to provide an Engine that does allow you to create your own reports.



Note: Most Data Base programs have their own report engines so you could use those programs to generate your own custom reports.



Ok, here is what you need to know:



	When you initiate a print routine in Ptools, that data is written to temporary file which the Report Engine uses to print. Remember, if you have a filter condition applied to clients, only the filtered records go to the temporary file.



	When using an outside program would first initiate the Ptools print command without actually physically printing the report. Then run the outside program, open your report template (that you have created with an identified *.DBF file) and then print.



	If your are creating a report template for the client file that does not require a filter condition, then you may identify CL.DBF which would be all clients in the data file. You would not have to initiate a print command.



CL.DBF or *.RDF 	The entire client database



Ptools Temporary Print Files:



PRNTEMP.DBF	Filtered Clients

LABTEMP.DBF	Custom Labels

ENVLOPE.DBF	Buffer or Custom Envelopes

MEMTEMP.DBF	Memo/Letter



Note: Most Data Base programs or Report Engines also have their own query or conditional functions which would allow you to create your own filters (queries) and use the CL.DBF (or *.RDF) file



PTUTIL



	The PTUTIL program is included for the following procedures:



Manipulate Cap First, UPPER, lower case of data files (All Modules)

Create Local Zip Code Data Base			(Client Module)

National Zip Code Directory				(Access Zip Data) 

Import to CL.DBF from ASCII File			(Import Client Data)

Export DBASE .DBF File					(Export Client Data)

Browse / Edit .DBF File					(Look at .DBF File)





	To start PTUTIL click Maintenance from the Main Menu and click PTUTIL



	The PTUTIL program (DOS) will start and a menu will appear from which you will select the desired action to perform.

 

�1	Cap First, UPPER and lower Case Data



	If you select this option you are prompted to enter a filename. You can process any DBASE file (19 field limit) with this routine. This function has been included primarily for the client and resource data files which you may want to convert at some time or another. I do not recommend changing the parts data bases as Capped First Words may look better, but lower case in the part numbers does not look appealing and may lead to confusion with parts orders.



	To see how this works, enter RESOURCE.DBF at the file name prompt. We are using resource for demonstration as you may not want to change the client file if your are using it and have entered considerable amounts of client data until you become familiar with the functionality of this routine.



	Having entered RESOURCE (CL for Client File) you are then presented with a field list that you mark Y or N for processing (they are pre marked for most likely scenario). Change any markings or press PgDn to continue. You are next prompted to enter C for Cap First, U  for all UPPER , or L for all lower. Enter U and then <ENTER> and all words/names will be converted to UPPER CASE. Now repeat this procedure with RESOURCE entering C for Cap First and the designated fields will have the first letter of each name/word capitalized. 



	Special Last Name situations are limited to McMullin and O'Conner and Walker-Parry type names so you will have to check and edit names like D'elia and Denormandie. One way to circumvent these situations is to enter your data in the form  De Normandie or Mc Phearson as these will Cap First properly.



2	Create Local Zip Code Data Base



	If you use the client module for client, accounts receivable, or buy/sell lists, you will want to create a local zip code data base. Select this option, press ENTER at the N (create new) prompt and enter the state abbreviation for the state where you reside followed by the ENTER key. A local zip code file will be created for your state which is used in the client module. You are then prompted with the option to add an additional state. If you live near a state border and have numerous clients in both states, add the additional state. You can add any amount of states this way but keep in mind that more states mean more towns to process when picking zip codes for data entry. I also recommend deleting towns and cities that contain more than 1 or 2 zipcodes as they are of little help anyway.



3	National Zip Code Directory



	If you select this option, you access the national zip code data base. Press F3 to find a town. Enter the name or partial name of the town and then the state abbreviation (i.e. nash tn) and Nashville TN zip codes will be displayed. The find command is NOT CasE seNsitive and any combination will work.



�National Zip Code Option:	(get zip codes from any directory)



	Copy ZC.BAT to a directory that is on your PATH (refer to DOS manual) and you can look up zipcodes from any directory of your computer. Please note that ZC.BAT specifies that PTUTIL.EXE and NZIP.DBF are located in your PTOOLS directory (\PTOOLS) so if you installed PTOOLS under a different directory name (\CLIENTS) ZC.BAT should be edited to reflect this.



	If you put ZC.BAT on the PATH the command to get a zip code from any DOS prompt will be:



C:>zc nash tn <ENTER>



Tip:



	If you are not familiar with the path command you can copy ZC.BAT to your root directory (start up state C:\>) with the following commands:



C:\>COPY \PTOOLS\ZC.BAT  <ENTER>



	ZC.BAT will be copied to your root directory. This assumes PTOOLS was installed in a directory named PTOOLS and your hard drive is assigned the letter C	



Import / Export Functions:	General Considerations



	Import and Export data functions have been included in PTUTIL to enable the user to move data in and out of the PTOOLS program. Import is currently limited to the CL.DBF or *.RDF Client File.



	It should be kept in mind that when moving data between different program formats, different degrees of data retention will be achieved depending on certain factors, primarily, the difference of the file structure between the two programs. For example, one program may store addresses in 21 spaces and the other, 25 spaces. In the transfer 4 spaces will be lost. Example 2: the source program may have 25 information fields and the target program, only 21. 4 information fields will have to be sacrificed. Etc.



	Most commercial database programs provide a means of importing and exporting data to and from different file formats. The most common medium for this is the ASCII DELIMITED File. The ASCII DELIMITED File is essentially a standard text file where each data entity (field) is separated by a comma, blank, ", or some other delimiter, and each record (client) is contained in one line. There are a few variations of the ASCII DELIMITED: DELIMITED, DELIMITED WITH BLANK, and DELIMITED WITH ? where ? is a character of your choice. Generally, I have found plain DELIMITED to be the best format for most purposes. If you are going to export from your program to import into CL.DBF, try to export to ASCII DELIMITED if possible. The results will look similar to:

"19931023","Parsons","Tremaine","Box 241","Georgetown",etc.

If not available your 2nd choice should be DELIMITED WITH ?, and 3rd choice, DELIMITED WITH BLANK.



	If you are using PTUTIL to export data, the preferred format depends on whether you will be moving the data to another pre defined data base file or one you will create. If pre defined, use ASCII DELIMITED.



"The Program I am using does not provide Export Capability"



	This is an inconvenient problem but not all may be lost. It is possible that some other user has encountered this problem and created a utility that will read your file and provide export functions(search CompuServe?). In addition, there are utility programs that redirect everything that you are printing (i.e. your client list) to a disk file instead of the printer. Using a utility such as this coupled with a little finagling, you can probably move data with reasonable results.



Tip:	Exporting your data to ASCII DELIMITED from your database



	Before you export any data to a ASCII Delimited file, pick a record (client) near the top of the file in your program and write down the specific contents of each field i.e. last tune = 10/24/93, Last Name = Parsons, First Name = Tremaine, etc. Also, fill in any empty or non obvious fields with some descriptive info i.e. SN# 337256 or this is comments field to help with field identification later. We will call this the reference record. This will prove worth while during the Import procedure.



4	Import to CL.DBF from ASCII File (or *.RDF)



	CL.DBF structure list at end of manual.



	This choice assumes you have exported your client data from your program to ASCII format, preferably ASCII DELIMITED. Also that you have under taken the Tip procedure above. The basic procedure is as follows: Supply the name of your ASCII file. Select a delimit format (hopefully choice 1 DELIMITED). The program will import your ASCII file into a temporary .DBF holding file and display your data on-screen. Using the up, down cursor keys, locate your reference record. If you can't see a date, use Ctrl -> to pan right to locate a date assuming your data contains dates. If so, you need to note the format left to right of the date. That is: the starting position of the 2 digit year, 2 digit month, and 2 digit day. i.e. 19931023 which would be	3 5 7	If for some reason, your dates do not include day, use 0 for day or	3 5 0	Press the Esc key to advance to the next screen and it will display a vertical field list of your reference record. The goal is to "label" your client fields with the CL.DBF field name that best matches your field. Field names you insert should be in UPPER CASE. If your data should have 2 dates, say, next tune and last tune, apply TDATE to next tune and PREVIOUS to last tune. Otherwise apply TDATE to last tune. Obviously, you would apply LAST to last name, FIRST to first name, ADDRESS to address, etc. If your program should store first and last names in one field, apply either FIRST, LAST, COMMENTS, or COMMENTS2 to your name field. You will have to edit each record later to correct this condition. You should try and achieve the best compromise in applying CL.DBF field names (UPPER CASE) to your data fields. Also, you may have to leave some of your data fields blank and this data will not be imported into CL.DBF. In addition, you might not apply every CL.DBF field name to one of your data elements.

 	Having carefully labeled your data fields with the CL.DBF field names, continue pressing the ENTER key to finish advancing to the bottom of the screen (or PgDn) and the import procedure will execute. A description screen will appear, read this, then press the space bar to continue. You are next prompted to save to a file. Press <ENTER> for Yes, and enter a filename. If you are importing to set up your new client file for Ptools, use CL.DBF. If you are creating an addl. .RDF file, enter a filename with a .RDF extension.



Warning:	This is one instance that Ptools will let you overwrite a CL.DBF file. Make sure that you don't overwrite a CL.DBF file in which you have entered a lot of data. In this case, save to a .RDF file and use Get From under Maintenance, Delete/Get and Append to your current CL.DBF.



5	Exporting DBASE .DBF file to ASCII



	This is a straight forward procedure. Supply a .DBF file name, supply a ASCII filename, select an ASCII format (1 DELIMITED for -> CL.DBF) and the designated .DBF file will be written to ASCII format.



6	Browse / Edit DBASE .DBF File



	This choice allows you to browse and edit any standard DBASE data file. Supply the file name and the screen will display the data. Use the cursor keys to navigate and then ENTER key to edit. Press Esc to Exit.



Possible Problems



	The following information is included in case you experience problems running the PTOOLS program.



	Ptools for Windows currently contains about 11,500 lines of programming code.



	I started Pscale for DOS in 1989, Ptools for DOS in early 1993 and Ptools for Windows in early 1995.

 	

	While developing these programs, I have “crashed” these programs thousands of times. Locked up the computer, come to a screeching halt with no cursor, gone to La La Land and then some. To date, I have never (knock on wood) lost any data as a result of program misbehavior. However, I also make sure that I have any files that I would never like to loose, backed up to a diskette. I have heard too many stories about hard disk failure.



	I have made every effort to make my programs “bullet proof” but will never be completely assured that they are. In fact, I think I can probably “crash” every program that I have ever created. Does this endear you with a great feeling of confidence in my programs??? Probably not. See Special Tip “How to Make Ptools Crash Now” Below.



	Not to worry, DBASE data files are very stable and there are many tools to repair them, if, they ever should get corrupted. I have never, knock on wood,(I’m almost asking for it) had to use one. I guess I am suspicious.

If you should get an ERROR MESSAGE while running Ptools:



	Please note the error message on paper so that you can inform me as to the nature of the error. This way, I can address the possible problem.



	There are two kinds of errors that you could possibly encounter:



Run Time Errors:



	These are Ptools specific errors that will present you with a choice of:



	Abort		Retry		Ignore



Abort		Recommended, this will exit the program. Just re-start.



Retry		This will just cause the error to repeat



Ignore	This  might continue the program - Will you know why ??





General Fault Protection Error:	(the dreaded “GPF”)



	If a “GPF” occurs in Ptools for Windows, the first screen you will see is :



DBFAST20	An Error has Occurred in Your Application 



Close		Ignore



Click Close



	The next screen you will see is:



Application Error! DBFAST20 Caused a General Protection Fault in module XXXX:XXXX



Close		Ignore



Click Close



	If you get a GPF, or General Protection Fault Error, in Ptools I suggest that you Re-Boot your system as the memory management has probably become confused or unreliable.



	As a rule, with any error, the safest course is one of caution. So select Abort or Close if you encounter any errors.



	I will take this opportunity so share with you that “GPF” errors can occur with some of the finest and most developed software available. I have encountered them in Word for Windows 6.0 and Corel Draw 3.0 running in Windows 3.1 The “GPF” just happens sometimes.



Special Tip:	How to Make Ptools Crash with a GPF Now!



	Go into Clients, select Reports, select Print Preview, preview the info, select File. Before you select Exit, get ready to press the Esc key. Click Exit and quickly press the Esc key. This should cause a GPF (see above). Click Close and then Re-Boot your system to be on the safe side.



	Please let me know if you should encounter any peculiar problems regarding the behavior for this program as I am always trying to correct any problems of this nature.



File Structures:



CL.DBF File Structure:



Field			Type			Width

 1	TDATE		Character		5	Last or Next Tuning Date

 2	DAY		Character		2 	Tuning Day

 3	TIME		Character		6 	Tuning Time

 4	CALL		Character		5 	Reminder Call

 5	MP		Character		10 	Multi Purpose

 6	FIRST		Character		20 	First Name

 7	LAST		Character		21 	Last Name

 8	ADDRESS	Character		28 	Address

 9	CITY		Character		21 	City

10	STATE		Character		4 	State

11	ZIP		Character		10 	Zip Code

12	PHONE		Character		12 	Phone

13	PHONE2	Character		12 	Alt.Phone

14	MFG		Character		20 	Manufacturer

15	TYPE		Character		7 	Type of Piano

16	PR		Character		1 	Pitch Raise or Other

17	COMMENTS	Character		52 	Remarks / Comments

18	COMMENTS2	Character		52 	Addl. Remarks / Comments

19	PREVIOUS	Character		52 	Tuning History

20	VTDATE	Numeric		6 	For Filtering Dates +-2000 

21	VCDATE	Numeric		6	For Filtering Dates +-2000 

22	CMEMO		Memo			5K	Addl. Client Info.

23	MTIME		Numeric		4	Military Time

24	CDAY		Character		2	Call Day

25	LASTSPEC	Character		15	Scheduling

26	YR		Character		2	Year

27	MO		Character		2	Month

28	CLCONAME	Character		40	School/Church/Co.    

29	MMSALUTE	Character		40	Personalized Merge/Memo “Dear”

�

PTOOLS REGISTRATION 















Name_______________________________________________________________



Address____________________________________________________________



Work Phone______________________ Home Phone________________________



Type of Computer________________ Printer___________________________



Type of Display _______________________ Amount of Memory___________



Disk Drive Size: 360K___ 720___ 1.2___ 1.4___ Program Version______



Date Purchased________________



Are you currently tracking clients with another program?___________



If Yes, What Program?______________________________________________



Do you have an EMAIL Adress ?______________________________________





Comments:

























Mail To:



Tremaine Parsons

Box 241

Goergetown CA. 95634
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